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Installing the PID Controller

The PID Controller can be installed as part of a client or server installation. 

To install the PID Controller we recommend that you first close down all applications. Insert DISK1 of the installation disks into the floppy drive and run A:\Setup.exe.

This will launch the PID Controller setup application. 
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Click on the Next button to continue.

The setup program will search for the product directory on the system and will display an error message if it’s not found. If the product directory is found the setup program will display the path that the PID Controller is to be installed to:


<drive>:\\<Product Directory>
Click on the OK button to continue.

Next, the user must configure how many PID Loops are to be installed on the system. The default is number is 10. 
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Enter the number of loops required and click on the Continue button. The setup program copies all the relevant files to your system. When complete the following message is displayed:

The PID Controller will be added as a new processor with the ‘PD’ prefix. In order for you to see this new processor the needs to restart.

PID Position Algorithm
Proportional-Integral-Derivative (PID) control algorithm is used to drive the process variable (measurement) to the preset value (setpoint). Temperature control is the most common form of closed loop control. For example, in a simple temperature control system the temperature of a vat of material is to be maintained at a given setpoint, s(t). The output of the controller sets the valve of the actuator to apply less heat to the vat if the current temperature of the vat is greater than the setpoint and more heat to the vat if the current temperature is less than the setpoint. The diagram below shows an example of such a system:
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Figure 1 Closed Loop Temparatue Control

The PID algorithm calculates its output by summing three terms. One term is proportional to the error (error is defined as the setpoint minus the current measured value). The second term is proportional to the integral of the error over time, and the third term is proportional to the rate of change (first derivative) of the error. The general form of the PID control equation in analog form is: 

Eqn. 1

m(t) = Kc * (  e(t) + Ki  ∫ e(t) dt + Kd  )

  proportional    integral     derivative

where:

m(t) = controller output deviation

Kc = proportional gain

Ki  = reset multiplier (integral time constant)

Kd = derivative time constant

S(t) = current process setpoint

X(t) = actual process measured variable (temperature, for example)

e(t) = error as a function of time = S(t) - X(t)

The variables Kc, Ki and Kd are adjustable and are used to customize a controller for a given process control application. The Ki constant term is listed in some textbooks as (1/Ki ). It is simply a matter of the units Ki is specified in. In the Ki form, the units are repeats per minute while in the 1/Ki form the units are minutes per repeat (also called reciprocal time). The Ki version presented here is preferred because increasing Ki will increase the integral gain action, just like increasing Kc and Kd will increase the proportional gain and derivative gain action. If 1/Ki is used, then decreasing values of Ki will increase the amount of integral gain.

The proportional term of the PID equation contributes an amount to the controller output directly proportional to the current process error. For example, if the setpoint of the process is 100 degrees and the current temperature of the process is 90 degrees, then the current process error is 10 degrees. The proportional term adds to the controller output an amount equal to Kc * 10. The gain term Kc determines how much the control output should change in response to a given error level. If the error is 10, a Kc gain of 0.5 will add 5 to the output of the controller, while a gain of 3 will add 30 to the output of the controller. The larger the value of Kc, the harder the system reacts to differences between the setpoint and the actual temperature. A PID controller can be used as a simple proportional controller by setting the reset rate and derivative time values to 0.0.

Simple proportional control cannot take into account load changes in the process under control. An example of a load for a temperature control loop is the ambient temperature of the room the process is in. The lower the ambient temperature of the room, the larger is the heat loss in the room. It will take more energy to maintain the vat at a given temperature in a cold room than in a warm room. A simple proportional controller cannot account for load changes which take place while the system is under control. Integral control converts the first-order proportional controller into a second order system which is capable of tracking process disturbances. It adds to the controller output a term that corrects for any changes in the load level of the system under control. This integral term is proportional to the sum of all previous process errors in the system. As long as there is a process error, the integral term will add more and more to the controller output until the sum of all previous errors is zero.

The term 'reset rate' is used to describe the integral action of a PID controller. The term derives from the output response of a PI controller (the derivative term set to zero in this case) to a step change in the process error signal. The response consists of an initial jump from zero to the proportional gain setting Kc, followed by a ramp (the integrating action of the integral term) which adds the initial proportional response each integral time T. Therefore the reset rate is defined as the repeats per minute of the initial proportional response.


3Kc


2Kc

Kc



T
2T
3T

Figure 2 PI Controller Response to a Step Input

For example, if the reset rate is 1.0, then for every minute that the error signal is non zero, the amount of corrective action added to the controller output by the integral term will be equal to the amount added by the proportional term alone. The higher the reset rate, the harder the system will react to non zero error terms.

The addition of the derivative term to the PI controller described above results in the classic three mode PID controller. The derivative action of a PID controller adds to the controller output the value proportional to the slope (rate of change) of the process error. The derivative term "anticipates" the error, providing a harder control response when the error term is going in the wrong direction and a dampening response when the error term is going in the right direction. It reduces overshoot for transient upsets. Proper use of the derivative term can result in much faster process response.

Computer based versions of the PID algorithm are based on sampled data discrete time control theory. The discrete time equivalent of the PID equation is:

Eqn. 2




   i

m(i) = Kc * (e(i) +   T * Ki  ∑ e(k) +     (Kd/T) * ( e(i) - e(i-1) )




  k=0

where

T = sampling interval

e(i) = error at ith sampling interval = S(t) -X(t)

e(i-1) = error at previous sampling interval

m(i) = controller output deviation

Kc = proportional gain

Ki = integral action time

Kd = derivative action time

The proportional term is the same between the Eqn. 1 and Eqn. 2. The integral term of the first equation is replaced by a summation term and the derivative term is replaced by the a first order difference approximation. In actual practice, the first order difference term, (ei - ei-1), is very susceptible to noise problems. In most practical systems this term is replaced by the more stable, higher order equation:

Eqn. 3

∆ e = (e(I)+ 3 * e)I-2) – e(I-3))/6

A common problem in discrete control systems arises from the summation of the error term for the integral action of the control equation. If a process maintains an error for a long period of time, it is possible that this summation can build to a very large numerical value. Even though the error term returns to zero or moves in the opposite direction, it will take a very long time to reduce the sum below the D/A saturation levels. Practical systems stop the summation of error terms if the current PID output level is outside a user specified range of high and low output values. This limiting of the summation term is commonly referred to as anti-reset-windup.

A PID object can operate in automatic or manual mode. When in manual, its output is not calculated but can be changed by the operator. A typical problem occurs when a PID object is switched from manual to automatic mode or when a PID constant is changed: the output value can change very quickly, possibly damaging the control equipment. All PID algorithms provided with this release use the "bumpless transfer" technique to prevent this problem. The algorithms also use the anti-reset-windup technique.

Velocity Algorithm

An altenative algorithm is called the velocity algorithm.

The basic formula for the velocity algorithm is:

Eqn. 4

∆m(i) = 
K1 * e(i) + K2 * e(i-1) + K3 * e(i-2)
where:


K1 = KC * (1.0 + (TKi) + Kd/T)

K2 = - (1.0 + 2.0 * (Kd/T)

K3 = - (Kd/T)

and


t = sampling interval


e(i) = error as a function of time = S(t) – X(t)


e(i-1) = error at previous sampling interval


e(i-2) = error at two sampling intervals ago


∆m(i) = relative controller output deviation

Kc = proportional gain

Ki  = reset multiplier (integral time constant)

Kd = derivative time constant

N.B. In using the velocity algorithm it is extremely important that the integral component (Ki) always be non-zero. Otherwise severe drift can occur in the output.

Implementing your own PID Control Algorithms

There is much contention in the industry about the effectiveness of different PID algorithms. Some algorithms are better suited to certain types of control environments For this reason the PID Controller system has been designed so that different algorithms can be swapped in or out as the user desires without having to change or recompile any code.

By using Microsoft’s COM technology we are able to replace or add new algorithms to the system. It is possible to develop your own algorithm or to buy a 3rd party vendor algorithm. All algorithm objects have a standard interface to the system. Support is provided for editing non-standard properties through the use of OLE Property Pages and the Edit|Extra Algorithm Properties command.

Contact your supplier for more information on implementing your own algorithms.

Running the PID Controller

The PID Controller application is PID_CF.exe and takes the following command line:


PID_CF [[/S <ServerName>] [loop_n]] [/T]
ServerName – The name of the server you want perform control on. If ServerName is “.” or blank then the local machine name is used.

Loop_n – The name of the PID loop configuration file you wish to open. Each loop configuration file name has the format Loop_n where n is the loop number (1 based).

/T – Use TCP-IP connection first instead of a mailslot connection

You can also launch the PID application 
from the Processors menu in the product main menu.

Configuring a PID Loop

To configure a PID Loop, click on the Loops tab of the Navigation Bar. The Navigation Bar lists all of the available loops in the system. Each entry in the Navigation Bar indicates the block of channels associated with the loop and the loop name. See the Navigation Bar section for help on using the navigation bar.

To open a PID Loop, click on an entry from the Navigation Bar and select the File Open command from the menu or toolbar. Alternatively, double-click on an entry in the Navigation Bar. 

The application opens the selected PID Loop document in a child window. The user is presented with the PID Loop displayed in a block diagram as shown below. Below the block diagram two graphs are shown. The graphs provide feedback to users as loops are configured/tuned.
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Configure the following Control Loop Properties:

Loop Name

The default name for a loop is “Loop<number>” which can be changed. A control loop name has a maximum of 10 alphanumeric characters and must not be blank. When the user changes the name, the tags of the channels associated with the loop renamed. See the Tuning Loops section for more information on the names of channels associated with loops.

Type

The type of control desired. The controller supports Analog Direct Output control and Digital On-Off control. Select one from the list.

Start-Up Mode

Select the mode you wish the loop to be in when the system is enabled. See Current Mode (below) for more details.

Start-Up Status

Select the status you wish the loop to be in when the system is enabled. See Current Status (below) for more details.

Current Mode & Current Status

A control loop can be in Manual or Automatic current mode. The loop can have an Enabled or Disabled current status. 

If a control loop has disabled status, it will not control outputs. The controller will read and display all inputs and output values.

If a control loop has enabled status and is in manual mode, it will control the outputs. The user can type in the output level by clicking on the analog output value. 

If a control loop has enabled status and is in automatic mode, it will control the outputs directly based on the results of the running algorithm.

N.B. We recommend that you configure the rest of the loop before switching the Mode and Status to Automatic and Enabled as the controller may try to control a partially configured loop.

Input

At the top of the block diagram the input channel and its current value are displayed. The 

input is the name of the process variable channel that is feedback input into the control loop. Click on the selection button to configure the input channel and other input properties such as the sample rate, low and high input limits and a filter value. An Input Properties property sheet is displayed showing all input details.

See the Input Properties section for more details on configuring input.

Setpoint

The setpoint value is the measured value that you want the loop to achieve. The difference between the setpoint and the current measured value is known as the Error. The setpoint value is displayed on the left-hand side of the block diagram. The error value is displayed to the right-hand side of the setpoint value.

You can enter the desired setpoint by double clicking on the setpoint value in the block diagram. An edit control will be displayed in-place with the value that you can change. When finished editing press the return key

Inverted Output

The Inverted Output flag specifies the direction of change of PID output relative to measurement. 

Click on the inverted output checkbox to enable inverted output.

Deadzone

The Deadzone value indicates an area around the setpoint at which no control takes place. It is possible to enter a range + or – for the Deadzone value. Click on the selection button to enter the Deadzone value. A Deadzone Properties property sheet is displayed showing all Deadzone details.

See the Deadzone Properties section for more details on configuring Deadzone.

Proportional Gain

Enter the Proportional Gain constant. The proportional term of the PID equation contributes an amount to the controller output directly proportional to the current process error.

You can enter the desired Proportional Gain by double clicking on the Proportional Gain value in the block diagram. An edit control will be displayed in-place with the value that you can change. When finished editing press the return key.

Integral Time

Enter the Integral Time constant. The Integral Time adds to the controller output a term that corrects for any changes in the load level of the system under control

You can enter the desired Integral Time by double clicking on the Integral Time value in the block diagram. An edit control will be displayed in-place with the value that you can change. When finished editing press the return key.

Derivative Time

Enter the Derivative Time constant. The derivative term "anticipates" the error, providing a harder control response when the error term is going in the wrong direction and a dampening response when the error term is going in the right direction.

You can enter the desired Derivative Time by double clicking on the Derivative Time value in the block diagram. An edit control will be displayed in-place with the value that you can change. When finished editing press the return key.

Analog Output

At the right-hand side of the block diagram the analog output channel and its current value are displayed. The output is the name of the process variable channel which is the written to by the controller. Click on the selection button to configure the output channel and other output properties such as the low and high output limits and a rate of change limit value. An Output Properties property sheet is displayed showing all output details.

See the Output Data Source Properties for more details on configuring the output data source.

See the Output PID Algorithm Properties for more details on configuring the PID Algorithm.

See the Output Scaling Properties for more details on configuring output scaling.

Digital Output [Digital On/Off Control Type Only]

At the very right-hand side of the block diagram the digital output channel and its current value are displayed. The Digital Output is the name of the digital process variable channel that the control loop drives. Click on the selection button to configure the digital output channel and other output properties such as the cycle length etc. A Digital Output Properties property sheet is displayed showing all output details.

See the Digital Output Data Source Properties for more details on configuring the digital output data source.

Time Scale

The graph at the bottom right-hand side of the window displays the setpoint, input and output values over time. Enter the desired timescale in seconds and click on the Update button to rescale the graph.

Configuring Input Properties

The input to the loop is the name of the process variable channel that is feedback input into the control loop. The Input Properties property sheet allows the user configure the following:
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Data Source Name

Select the data source for the input channel. The system will list every data source available on the current server. As you select a data source, its prefix is displayed in an edit box to the right hand side of the list. If desired you can select the USER_DEFINED data source and enter your own channel prefix in the edit box.

Channel

Select the input channel from the data source. As you select channels the channel number is displayed in an edit box to the right hand side of the list. Only channels that have been enabled and configured will be shown in this list. If desired you can select the USER_DEFINED channel and enter your own channel number in the edit box.

Low Limit

Click the Low Limit check box on to enable input low limiting. Enter the limit value in the edit box to the right-hand side of the check box.

High Limit

Click the High Limit check box on to enable input high limiting. Enter the limit value in the edit box to the right-hand side of the check box.

Filter Value

Enter the desired filter value. The filter must be a value in the range 0.0 to 1.0, affecting the filtering of the noisy measurement signal. A value of 0.0 means that no filtering takes place. The filtering effect is maximal when value is 1.0. The formula for filtering is:


Filtered value = (1.0 - value) * Measured value +  value
 * (Previous filtered value)

Sample Rate

Sample period of PID updates, in milliseconds.

N.B. In using a PID algorithm it is important that the sample rate set to be non-zero. A zero value will cause the controller to calculate an average sample rate.

Configuring Deadzone Properties

The Deadzone value indicates an area around the setpoint at which no control takes place. It is possible to enter a range + or – for the Deadzone value. 
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The Deadzone Properties property sheet allows the user configure the following:

Enable Deadzone Checking

Click this checkbox on if you want Deadzone limitimt enabled.

Deadzone Value

Enter the Deadzone value in the edit box.

Deadzone Range

Select one off the following ranges:


Plus Value

e.g. +5


Minus Value 

e.g. -5


Plus & Minus Value 
e.g. +5 and – 5

Configuring Output Data Source Properties

The output is the name of the process variable channel which is the written to by the controller. The Output Source property page allows the user configure the following:
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Data Source Name [Analog Control only]

Select the data source for the output channel. The system will list every data source available on the current server. As you select a data source, its prefix is displayed in an edit box to the right hand side of the list. If desired you can select the USER_DEFINED data source and enter your own channel prefix in the edit box.

Channel [Analog Control only]

Select the output channel from the data source. As you select channels the channel number is displayed in an edit box to the right hand side of the list. Only channels that have been enabled and configured will be shown in this list. If desired you can select the USER_DEFINED channel and enter your own channel number in the edit box.

Low Limit

Enter the output low limit value in the edit box. 

High Limit

Enter the output high limit value in the edit box.

Rate of Change Limit

Enter the output rate of change limit value in the edit box.

N.B. In using a PID algorithm it is extremely important that the rate of change limit be set to be non-zero. Otherwise the algorithm may fail to operate correctly.

Steady State

Enter the steady state value for the output channel.

Configuring PID Algorithm Properties

The PID Algorithm property page allows the user select a PID Algorithm from a list all registered algorithm objects in the system.
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Select the desired algorithm by clicking on it with the mouse.

See the PID Algorithms section for more information on configuring non-standard PID Algorithm properties.

Configuring Output Scaling Properties

N.B. Scaling is available only on Analog Direct Output control loops.
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To enable scaling check the Scaling Check box on. The Slope  and Offset values can be entered directly.  The formula applied is:


y = mx + c       where:
m is SLOPE





x is the measured value.





c is the OFFSET  

Configuring Digital Output Properties

The Digital Output is the name of the digital process variable channel that the control loop drives control loop. The Digital Output Properties property sheet allows the user configure the following:
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Data Source Name

Select the data source for the digital output channel. The system will list every data source available on the current server. As you select a data source, its prefix is displayed in an edit box to the right hand side of the list. If desired you can select the USER_DEFINED data source and enter your own channel prefix in the edit box.

Channel

Select the digital output channel from the data source. As you select channels the channel number is displayed in an edit box to the right hand side of the list. Only channels that have been enabled and configured will be shown in this list. If desired you can select the USER_DEFINED channel and enter your own channel number in the edit box.

Output Mode

Select the desired output mode. Two modes of digital output are supported – Pulse width mode specifies the duration of a pulse. Frequency mode specifies how many pulses to give out.

Cycle Length

Enter the cycle length for the digital output. Cycle length is the duration in milliseconds used to drive digital outputs. Cycle length must be greater than zero.

Maximum Frequency [Frequency Mode Only]

Enter the maximum frequency value allowed. Maximum frequency must be greater than zero, must not be greater than cycle length and, must evenly divide into cycle length.

Configuring the PID Processor

The PID Controller’s runtime is implemented a system processor with the ‘PD’ prefix. This processor is responsible for running each configured loop in the system, reading inputs, calling the PID Algorithm object’s methods, and driving outputs.

Associated with the processor is the Auto Enable feature. When the Auto Enable feature is on, the PID Controller processor will begin running/controlling loops when the system is enabled. To configure the Auto Enable feature, click on the Advanced tab in the Navigation Bar. This will present all the advanced processor configuration options. Check the AutoEnable Processor checkbox on to enable the feature.

[image: image13.png]¥ AutoEnable Processor




The PID Controller supports a configurable number of PID Control Loops. A fixed block of channels (20) are assigned to each loop. This allows a loop to be monitored and tuned from both this application and existing applications such as the Configurable Monitor. The total number of channels allocated to the PID processor is configured in the datproc.txt file located in the system’s CURRENT_CONFIG directory. The processors channel prefix can also be changed here.

Tuning a PID Loop

When the loop is in Automatic mode and Enabled status it begins to calculate PID output. The user can tune a PID Control Loop by adjusting the PID parameters such as the Proportional Gain constant and the Integral Time constant. See the PID Control Overview for an overview of PID Control.

You can enter a value in the loops block diagram window by double clicking on the value you want to change. If the value is editable an edit control will be displayed in-place with the value that you can change. When finished editing press the return key. Other parameters can be changes by clicking on the appropriate selection button.

The PID application reads channel values associated with a control loop from a data module. These channels are called configuration channels and the interaction between these channels updating and the control loop configuration on disk require consideration:

Initially the application reads channel values from the control loop configuration on disk. When the algorithm executes, channel values are set in the data modules. The application reads these values from the data modules. The user may change a variable, e.g. proportional gain, in order to tune the loop. The data modules are written to with the new values. If the variable is channel-based the PID algorithm will attempt to adjust automatically. If the variable changed is not channel based, the algorithm adjusts when the Control|Reconfigure option is selected. The reconfigure command forces the runtime to reload the loop configuration from the disk.

This data is not written to the disk until the user selects the File|Save option. 

Each control loop is assigned a set of channels. The tag for each channel is the control loop name prefixed with the mnemonic for each channel as follows:

	No
	Mnemonic
	Description
	Units
	Low/High State

	1
	SP
	Setpoint
	Input PV Units
	

	2
	PG
	Proportional Gain
	%
	

	3
	IT
	Integral Time
	Secs
	

	4
	DT
	Derivative Time
	Secs
	

	5
	DZ
	Deadzone
	Input PV Units
	

	6
	SS
	SteadyState Value
	Units of output Channel or %
	

	7-10
	Reserved
	
	
	

	11
	CM
	Current Mode
	
	Manual/

Automatic

	12
	CS
	Current Status
	
	Enabled/

Disabled

	13
	PV
	Process variable
	Input PV Units
	

	14
	AO
	Current output value
	Units of output Channel or %
	

	15
	DO
	Digital output value
	
	Descriptions of

Digital output

	16
	SF
	Save Flag
	
	

	17-20
	UN
	Reserved
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The two graphs in the control loop window provide the user with feedback when the loop is controlling. 

The bar graph on the left-hand side displays the following values:


Input

Blue


Setpoint
Green


Output

Red

The scrolling graph on the right-hand side displays the same values (in the same colors) over a specified period of time. By monitoring these graphs the user can analyze the performance of the loop when it is running.

PID Application Menu Commands

File menu commands

The File menu offers the following commands:

	Open
	Opens an existing PID Loop document.

	Close
	Closes an opened PID Loop document.

	Save
	Saves an opened PID Loop document using the same file name.

	Print
	Prints a PID Loop document.

	Print Preview
	Displays the PID Loop document on the screen as it would appear printed.

	Print Setup
	Selects a printer and printer connection.

	Exit



	Exits PID Controller.


Edit menu commands

The Edit menu offers the following commands:

	Copy
	Copies PID Loop data from the document to the clipboard.

	Paste
	Pastes PID Loop data from the clipboard into the document.

	Extra Algorithm Properties
	Edits extra PID Algorithm properties.


View menu commands

The View menu offers the following commands:

	Toolbar
	Shows or hides the toolbar.

	Status Bar
	Shows or hides the status bar.

	Navigation Bar
	Shows or hides the navigation bar.


Control menu commands

The Control menu offers the following commands:

	Reconfigure
	Reconfigures the PID Controller processor in memory


Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple documents in the application window:

	Cascade
	Arranges windows in an overlapped fashion.

	Tile
	Arranges windows in non-overlapped tiles.

	Arrange Icons
	Arranges icons of closed windows.

	Window 1, 2, ...
	Goes to specified window.


Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

	Help Topics
	Offers you an index to topics on which you can get help.

	About
	Displays the version number of this application.


Navigation Bar
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The navigation bar is initially displayed at the left side of the PID Controller window.  It is a dockable window that can be docked anywhere inside the main window or left floating. The application will remember the last size, position and docking state of the window when restarted. To display or hide the navigation bar, use the Navigation Bar command in the View menu. 

At the bottom of the Navigation Bar is a Tab Control with the following tabs:

Loops

The loops tab is used for identifying and opening PID Loops. It contains a list view control. Each entry in the list view control indicates the block of channels associated with a loop and the loop’s name. The list view control can be sorted by channels or by loop name. To sort the list, click on the desired column header.

Advanced

The advanced tab presents all of the advanced processor configuration options.
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